
Создание Рабочих Элементов

Рабочие элементы - специальные конструктивные элементы, которые Вы используете
для размещения геометрии, которую иначе очень трудно размещать параметрически.

Привязывая эскизные и типовые элементы к рабочим элементам, которые, в свою
очередь, ограничивают вашу деталь, Вы можете легко управлять их местоположением
путем изменения положения рабочего элемента.

Настоящее учебное пособие научит Вас, как использовать рабочие элементы, чтобы
управлять положением эскизных элементов. Вы изучите каждый из этих элементов.

Ключевые термины

Термин Определение
Nonparametric Work Plane

(Непараметрическая
рабочая плоскость)

Рабочая плоскость, привязанная к определенному месту
относительно детали. Если геометрия детали параметрически
изменяется, то это не влияет на рабочую плоскость

Parametrics

(Параметризация)

Метод решения, который использует значения параметров детали
для определения геометрического профиля детали

Parametric Work Plane

(Параметрическая рабочая
плоскость)

Рабочая плоскость, связанная и зависящая от граней, поверхностей,
плоскостей, вершин и осей детали

Sketch plane

(Эскизная плоскость)

Временная поверхность рисунка, которая соответствует реальной
плоскости на элементе. Это бесконечная по осям Х и Y плоскость, на
которой Вы делаете эскиз или размещаете элемент.

Work axis

(Рабочая ось)

Параметрическая конструктивная линия, созданная по осевой линии
цилиндрического элемента или нарисованная в текущей эскизной
плоскости. Рабочая ось может использоваться как ось вращения для
элементов вращения или протягивания, массива элементов, для
размещения рабочей плоскости и геометрии нового эскиза. Она
может включаться в размеры.

Work feature

(Рабочий элемент)

Плоскости, оси и точки используемые для размещения
геометрических элементов на активной детали.

Work plane

(Рабочая плоскость)

Бесконечная плоскость, присоединенная к детали. Может быть
обозначена как плоскость эскиза и может быть включена в схему
размеров или зависимостей. Рабочие плоскости могут быть
параметрическими или непараметрическими.

Work point

(Рабочая точка)

Параметрический рабочий элемент, используемый для размещения
отверстия, центра массива или любая другая точка, на которую не
ссылается никакая другая геометрия.
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Краткий Обзор Урока

Новые особенности в этом уроке

Настоящее учебное пособие разработано, чтобы помочь Вам понять основы создания
рабочих элементов. Некоторые из новых элементов и улучшений в Mechanical Desktop 4
показаны в настоящем учебном пособии

• Использование нового контекстно-зависимого меню, выпадающего по щелчку правой
кнопки мыши для доступа к командам

• Использование улучшенного интерфейса командной строки

Дополнительную информацию по новым и усовершенствованным элементам, см. главу
3, «Новые Особенности» в руководстве «Начинаем работать».

Базовая Концепция Рабочих Элементов

Когда Вы создаете параметрическую деталь, Вы определяете, как связаны между собой
элементы детали. Изменение одного элемента непосредственно воздействует на все
элемента, связанные с ним.

Рабочие элементы - специальные конструктивные элементы, которые помогают Вам
определить отношения между элементами Вашей детали. Они обеспечивают контроль
при размещении эскизов и элементов. Любые изменения в положении рабочих
элементов непосредственно влияют на размещение эскизов и элементов, связанных с
ними.

Вы можете использовать рабочие элементы для определения:

• Плоскости для размещения эскизов и элементов

• Плоскости или кромки для размещения параметрических размеров и зависимостей

• Оси или точки поворота для элементов вращения, протягивания и массивов

Имеются три типа рабочих элементов: рабочие плоскости, рабочие оси и рабочие точки.
В настоящем учебном пособии, Вы изучите основы создания и изменения каждого из
этих рабочих элементов.

Откройте файл w_feat.dwg в папке desktop\tutorial.

ОБРАТИТЕ ВНИМАНИЕ Сделайте резервную копию файлов учебных чертежей, чтобы
Вы имели оригинальные файлы на случай ошибки. См. «Резервное Копирование Файлов
Учебных Чертежей» на странице 7.

Рисунок содержит три простых детали.
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Каждая деталь имеет эскиз профиля, связанный с ней. Вы создадите рабочие элементы
для управления поведением каждого из эскизов.

Создание Рабочих Плоскостей
Рабочая плоскость - бесконечная плоскость, которую Вы присоединяете к вашей детали.
Она может быть параметрической или непараметрической. Рабочая плоскость может
также использоваться для определения плоскости эскиза для новой геометрии. Чтобы
разместить элемент, который не лежит в той же плоскости, что и ваш базовый элемент,
Вы определяет новую плоскость и, затем, создает элемент. Если плоскость
параметрическая, любые ее изменения влияют на положение элемента.

Рабочая плоскость определяется двумя модификаторами. Модификаторы определяют,
как плоскость будет ориентирована. Правильно выбирая модификаторы, Вы можете
создавать рабочую плоскость так, как Вам необходимо для размещения геометрии.

Параметрические рабочие плоскости могут быть созданы указанием граней, осей или
вершин и указанием, является ли плоскость нормальной, параллельной или касательной
к выбранной геометрии. Непараметрические рабочие плоскости могут быть созданы в
текущей системе координат (UCS), или на любой из трех плоскостей Мировой Системы
Координат (WCS).

Для получения дополнительной информации относительно создания рабочих
плоскостей, см. AMWORKPLN в онлайновом Справочнике Команд.

PART1_1 содержит элемент выдавливания с профилем, привязанным к задней
поверхности.

ОБРАТИТЕ ВНИМАНИЕ Для ясности, параметрические размеры не показаны.

Профиль будет использоваться для вырезания материала из детали. Выдавливая
профиль до рабочей плоскости, Вы можете легко управлять глубиной выдавливания,
изменяя положение плоскости.

Сначала, Вы создадите рабочую плоскость через плоскость симметрии детали и
выдавите до нее профиль. Затем, Вы отредактируете положение рабочей плоскости,
чтобы изменить глубину нового выдавливания.

Для создания рабочей плоскости
1. Увеличьте масштаб изображения PART1_1.

Пиктограмма Zoom Window

Меню Desktop Zoom →  Window

Команда ZOOM
Specify corner of window, enter a scale factor (nX or nXP), or

[All/Center/Dynamic/Extents/Previous/Scale/Window] <real time>: Введите w
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Specify first corner: Укажите точку слева и выше PART1_1

Specify opposite corner: Укажите точку справа и ниже PART1_1

2. Создайте рабочую плоскость через плоскость симметрии PART1_1.

Контекстное Меню В графической области, щелкните правой кнопкой мыши и
выберите Sketched & Work Features → Work Plane.

Пиктограмма Work Plane

Меню Desktop Design → Work Features → Work Plane

Команда AMWORKPLN

3. В диалоговом окне Work Plane Feature укажите:
1st Modifier: Planar Parallel

2nd Modifier: Offset

Offset: Введите 0.5

Нажмите ОК.

4. Продолжите в командной строке.
Select work plane, planar Face or [worldXy/worldYz/worldZx/Ucs]:

Укажите переднюю плосокость
Enter an option [Next/Accept] <Accept>:

Перебирайте n до выбора передней поверхности ли нажмите ENTER

Enter an option [Flip/Accept] <Accept>:

Введите f для указания стрелки внутрь детали

Enter an option [Flip/Accept] <Accept>: нажмите ENTER

Plane = Parametric
Select edge to align X axis or [Z-flip/Rotate] <accept>: нажмите ENTER

Рабочая плоскость теперь делит деталь пополам.
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Затем, выдавите профиль до рабочей плоскости.

Для выдавливания профиля до плоскости
1. Выдавите профиль.

Контекстное Меню В графической области, щелкните правой кнопкой мыши и
выберите Sketched & Work Features → Extrude.

Пиктограмма Extrude

Меню Desktop Part → Sketched Features → Extrude

Команда AMEXTRUDE

2. В диалоговом окне Extrusion Feature укажите следующее:
Operation: Cut

Termination: To Face/Plane

3. Нажмите ОК для выхода из диалогового окна и продолжите в командной строке.
Select Face or work plane: Укажите рабочую плоскость

Профиль выдавится до рабочей плоскости.

Теперь изменяйте положение рабочей плоскости для управления глубиной
выдавливания, которое Вы только что создали.

Редактирование Рабочих Плоскостей
Поскольку непараметрическая рабочая плоскость статична, любые элементы, связанные
с ней, ограничены первоначальной плоскостью. Если Вы изменяете положение или
ориентацию вашей детали, элементы остаются связанными с рабочей плоскостью и
ваша деталь не сможет обновиться.

По возможности, размещайте ваши элементы на параметрических рабочих плоскостях.
Когда Вы изменяете положение параметрической рабочей плоскости, Вы изменяете тем
самым положение всех элементов, созданных на ней или привязанных к ней.
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Для изменения положения рабочей плоскости
1. Переместите рабочую плоскость.

Контекстное Меню В графической области, щелкните правой кнопкой мыши и
выберите Edit Features → Edit.

Пиктограмма Edit Features

Меню Desktop Part → Edit Feature

Команда AMEDITFEAT

2. Ответьте на запросы  следующим образом:
Enter an option [Independent array instance/Sketch/surfCut/Toolbody/select

Feature] <select Feature>: Укажите рабочую плоскость

Select object: Укажите величину 0.5

Enter dimension value <.5>: Введите 0.15

Select object: нажмите ENTER

ОБРАТИТЕ ВНИМАНИЕ Если вы используете Обозреватель Вас не запросят указать
рабочую плоскость.

3. Обновите деталь.

Обозреватель Щелкните по пиктограмме Update Part.

Контекстное Меню В графической области, щелкните правой кнопкой мыши и
выберите Update Part

Пиктограмма Update Part

Меню Desktop Part → Update Part

Команда AMUPDATE

4. Ответьте на подсказку следующим образом:
Enter an option [active Part/All parts] <active Part>: нажмите ENTER

Если Вы используете Обозреватель, подсказка не отображается.

Ваша деталь должна быть похожей на:

5. Сохраните ваш файл.
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Создание рабочих осей
Рабочая ось - параметрическая конструктивная линия, используемая в качестве оси
вращения для вращения или протягивания элемента, или массива элементов; она также
используется для размещения рабочей плоскости  и расположения новой геометрии
эскиза. Вы можете создавать рабочую ось в центре цилиндрической кромки или рисовать
ее в текущей плоскости эскиза, указывая любые две точки.

PART2 содержит простой элемент вращения, рабочую плоскость и частично
ограниченный профиль. Вы создадите рабочую ось через центр детали. Затем Вы
привяжете профиль к рабочей оси так, чтобы можно было вырезать материал из
базового элемента.

ОБРАТИТЕ ВНИМАНИЕ Для ясности, параметрические размеры не показаны.

Сначала, создайте рабочую ось через центр детали.

Для создания рабочей оси
1. Активизируйте PART2.

Обозреватель Щелкните правой кнопкой мыши по пиктограмме PART2_1 и
выберите Activate Part.

Контекстное Меню В графической области, щелкните правой кнопкой мыши и
выберите Part → Activate Part.

Пиктограмма Activate Part

Меню Desktop Part → Part → Activate Part

Команда AMACTIVATE

2. Ответьте на запросы следующим образом:
Enter an option [Assembly/Part/Scene] <Part>: нажмите ENTER

Select part to activate or [?] <PART1_1>: Укажите деталь

3. Панорамируйте рисунок так, чтобы PART2 разместилась в графическом экране.

Контекстное Меню В графической области, щелкните правой кнопкой мыши и
выберите Pan.

Пиктограмма Pan Realtime

Меню Desktop View → Pan → Realtime

Команда PAN
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4. Создайте рабочую ось.

Контекстное Меню В графической области, щелкните правой кнопкой мыши и
выберите Sketched & Work Features → Work axis.

Пиктограмма Work axis

Меню Desktop Design → Work Features → Work axis

Команда AMWORKAXIS

5. Ответьте на подсказку следующим образом:
Select cylinder, cone or torus [Sketch]: Выберите цилиндрическую кромку

Поскольку рабочая ось проходит через центр детали, никакие зависимости не требуются.

Затем, привяжите профиль к новой рабочей оси и создайте относительно нее элемент
вращения.

Для ограничения и вращения профиля

1. Привяжите профиль к рабочей оси, добавляя два размера.

Контекстное Меню В графической области, щелкните правой кнопкой мыши и
выберите Dimensioning → New Dimension.

Пиктограмма New Dimension

Меню Desktop Dimensioning → Dimensioning → New Dimension

Команда AMPARDIM

2. Ответьте на запросы  следующим образом:
Select first object: Укажите правую кромку профиля (1)

Select second object or place dimension: Укажите рабочую ось (2)

Specify dimension placement: Разместите размер (3)

Enter dimension value or [Undo/Hor/Ver/Align/Par/aNgle/Ord/Diameter/pLace]

<0.8324>: Введите h для горизонтального размера

Enter dimension value or [Undo/Hor/Ver/Align/Par/aNgle/Ord/Diameter/pLace]

<0.1671>: Введите 0

Solved underconstrained sketch requiring 1 Dimensions or constraints.

Select first object: Укажите верхнюю кромку профиля (4)

Select second object or place dimension: Укажите верхнюю кромку детали (5)

Specify dimension placement: Разместите вертикальный размер (6)

Enter dimension value or [Undo/Hor/Ver/Align/Par/aNgle/Ord/Diameter/pLace]

<0.1333>: Введите 0
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Solved fully constrained sketch.

Select first object: нажмите ENTER

3. Создайте элемент вращения из профиля.

Обозреватель Щелкните правой кнопкой мыши по Profile2 и выберите Revolve.

Контекстное Меню В графической области, щелкните правой кнопкой мыши и
выберите, Sketched & Work Features → Revolve.

Пиктограмма Revolve

Меню Desktop Part → Sketched & Work Features →  Revolve

Команда AMREVOLVE

4. Ответьте на подсказку следующим образом:
Select Revolution axis: Выберите рабочую ось

5. В диалоговом окне Revolution (Вращение), укажите:
Operation: Cut

Termination: By angle

Angle: Введите 360

Нажмите ОК для выхода из диалогового окна.

Ваш рисунок должен быть похожим на:

Сохраните ваш файл.
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Редактирование Рабочих Осей
Рабочие оси являются параметрическими и, поэтому, любые изменения параметров,
контролирующих рабочие оси воздействует на положение элементов, привязанных к ним.

В этом упражнении, рабочая ось была проведена через центр цилиндрического объекта
и не может быть установлена в новое место. Но, при изменении одного из размеров,
который привязывает профиль к оси, изменяется элемент вращения.

Для изменения элемента вращения, Вы измените горизонтальный размер,
привязывающий профиль к рабочей оси. В этом упражнении, т.к. значение размера - 0,
изменение его изменит профиль в ошибочном направлении. Для требуемого
перемещения профиля, сотрите размер, немного переместите профиль и, затем,
добавьте новый горизонтальный размер.

Для перемещения профиля, привязанного к рабочей оси
1. Отредактируйте элемент вращения в Обозревателе.

Обозреватель Щелкните правой кнопкой мыши по Revolution Angle1 и выберите
Edit Sketch.

2. Сотрите размер, привязывающий профиль к рабочей оси.

Контекстное Меню В графической области, щелкните правой кнопкой мыши и
выберите 2D Sketching → Erase.

Пиктограмма Erase

Меню Desktop Modify → Erase

Команда ERASE

3. Переместите профиль, включая все его размеры, влево от его текущего положения.

Контекстное Меню В графической области, щелкните правой кнопкой мыши и
выберите 2D Sketching → Move.

Пиктограмма Move

Меню Desktop Modify → Move

Команда MOVE

4. Ответьте на запросы следующим образом:
Select objects: Введите w

Specify first corner: Укажите точку сверху и левее размера 0.15

Specify opposite corner: Укажите точку сверху и левее размера 0.30

11 found
Select objects: нажмите ENTER

Specify base point or displacement: Укажите любую точку

Specify second point of displacement or <use first point as displacement>:

Укажите точку слева от базовой точки

ОБРАТИТЕ ВНИМАНИЕ Нажмите F8 для включения ортогонального режима до указания
базовой и второй точек.
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5. Создайте новый параметрический размер.

Контекстное Меню В графической области, щелкните правой кнопкой мыши и
выберите Dimensioning → Edit Dimension.

Пиктограмма Edit Dimension

Меню Desktop Design → Dimensioning → Edit Dimension

Команда AMMODDIM

6. Ответьте на запросы  следующим образом:
Select first object: Укажите правую кромку профиля

Select second object or place dimension: Укажите рабочую ось

Specify dimension placement: Разместите размер

Enter dimension value or [Undo/Hor/Ver/Align/Par/aNgle/Ord/Diameter/pLace]

<0.4347>: Убедитесь, что размер горизонтальный и Введите 0.15

Solved fully constrained sketch.

Select first object: нажмите ENTER

7. Обновите деталь.

Обозреватель Щелкните по пиктограмме Update Part.

Контекстное Меню В графической области, щелкните правой кнопкой мыши и
выберите Update Part

Пиктограмма Update Part

Меню Desktop Part → Update Part

Команда AMUPDATE

8. Ответьте на подсказку следующим образом:
Enter an option [active Part/All parts] <active Part>: нажмите ENTER

Ваш рисунок должен быть похожим на:

Сохраните ваш файл.

Создание Рабочих Точек
Рабочая точка - параметрическая точка для позиционирования элементов, которые не
могут быть легко расположены на детали. Привязывая элемент к рабочей точке, а
рабочую точку – к детали, Вы получаете возможность контролировать положение
элемента.

Используйте рабочие точки для
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− Позиционирования эскизных элементов.

− Создания центров полярных массивов.

− Размещения элементов рассечения поверхности.

− Размещения отверстий, когда концентрические цилиндрические кромки или две
плоских кромки - недоступны

PART3 содержит простой цилиндрический элемент выдавливания с рабочей осью в ее
центре и эскизом на верхней плоскости.

Вы разместите рабочую точку в плоскости эскиза и сделаете профиль. Затем, Вы
привяжите профиль к рабочей точке, а рабочую точку к рабочей оси.

Для создания и ограничения рабочей точки
1. Активизируйте PART3 и панорамируйте рисунок так, чтобы деталь разместилась в

графическом экране.

2. Создайте рабочую точку в центре эскиза.

Контекстное Меню В графической области, щелкните правой кнопкой мыши и
выберите Sketched & Work Features → Work Point.

Пиктограмма Work Point

Меню Desktop Design → Work Features → Work Point

Команда AMWORKPT

3. Ответьте на подсказку следующим образом:
Specify the location of the workpoint: Укажите точку в центре эскиза

ОБРАТИТЕ ВНИМАНИЕ Вам может понадобиться отключить ОБЪЕКТНУЮ ПРИВЯЗКУ
до создания и ограничения рабочей точки. Щелкните по кнопке OSNAP внизу вашего
экрана.

4. Привяжите рабочую точку к рабочей оси.

Контекстное Меню В графической области, щелкните правой кнопкой мыши и
выберите Dimensioning → New Dimension.

Пиктограмма New Dimension

Меню Desktop Dimensioning → Dimensioning → New Dimension

Команда AMPARDIM

5. Ответьте на запросы  следующим образом:
Select first object: Укажите рабочую точку

Select second object or place dimension: Укажите рабочую ось

Specify dimension placement: Разместите размер

Enter dimension value or [Undo/Hor/Ver/Align/Par/aNgle/Ord/Diameter/pLace]
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<0.5890>: Убедитесь, что размер горизонтальный и введите 0.6

Solved underconstrained sketch requiring 1 Dimensions or constraints.

Select first object: Укажите рабочую точку

Select second object or place dimension: Укажите рабочую ось

Specify dimension placement: Разместите размер

Enter dimension value or [Undo/Hor/Ver/Align/Par/aNgle/Ord/Diameter/pLace]

<0.6130>: Убедитесь, что размер вертикальный и введите 0.

Solved fully constrained sketch.

Select first object: нажмите ENTER

Определите эскиз и привяжите его к рабочей точке.

Для определения эскиза и привязки его к рабочей точке
1. Перейдите к виду сверху вашей детали.

Пиктограмма Top View

Меню Desktop View → 3D Views → Top

2. Определите эскиз.

Контекстное Меню В графической области, щелкните правой кнопкой мыши и
выберите Sketch Solving → Profile.

Пиктограмма Profile

Меню Desktop Design → - Sketch Solving → Profile

Команда AMPROFILE

Ответьте на запросы следующим образом:
Select objects for sketch: Укажите прямоугольный эскиз

Select objects for sketch: нажмите ENTER

Solved underconstrained sketch requiring 8 Dimensions or constraints.

ОБРАТИТЕ ВНИМАНИЕ Хотя многоугольник - единственный объект, Вы не можете
использовать Single Profile (Единичный Профиль) для его определения, потому что он не
является последним созданным объектом.

Профиль требует восьми зависимостей: шесть для определения и два для привязки его к
рабочей точке.

3. Увеличьте изображение профиля и наложите на него зависимости, используя размеры в
следующей иллюстрации.
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Вы можете также использовать зависимость Equal Length (Равной Длины) для сегментов
линии, чтобы уменьшить число требуемых размеров.

4. Привяжите профиль к рабочей точке.

ОБРАТИТЕ ВНИМАНИЕ Для ясности, размеры профили не показываются.

Профиль теперь полностью определен. Затем, Вы создадите элемент выдавливания,
чтобы вырезать материал из базового элемента.

Для выдавливания элемента сквозь деталь
1. Перейдите к изометрическому виду.

Пиктограмма Right Front Isometric View

Меню Desktop View → 3D Views → Right Front Isometric

2. Выдавите профиль сквозь деталь.

Обозреватель Щелкните правой кнопкой мыши по Profile2 и выберите Extrude

Контекстное Меню В графической области, щелкните правой кнопкой мыши и
выберите Sketched & Work Features → Extrude.

Пиктограмма Extrude

Меню Desktop Part → Sketched Features → Extrude

Команда AMEXTRUDE

3. В диалоговом окне Extrusion Feature укажите:
Operation: Base

Termination: Through

Нажмите ОК.
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ОБРАТИТЕ ВНИМАНИЕ Размеры, контролирующие рабочую точку все еще видимы,
потому что рабочая точка не была использована для элемента.

Сохраните ваш файл.

Редактирование Рабочих Точек
Далее, чтобы переместить элемент выдавливания Вы должны изменить размеры,
привязывающие рабочую точку к рабочей оси. Элемент выдавливания и рабочая точка
связанны параметрически; любое изменение в положении рабочей точки заставляет
смещаться элемент выдавливания.

Для редактирования рабочей точки
1. Измените вертикальный размер эскиза, контролирующий рабочую точку.

Контекстное Меню В графической области, щелкните правой кнопкой мыши и
выберите Dimensioning → Edit Dimension.

Пиктограмма Edit Dimension

Меню Desktop Design → Dimensioning → Edit Dimension

Команда AMMODDIM

Ответьте на запросы следующим образом:
Select dimension to change: Укажите вертикальный размер

New value for dimension <0.6000>: Введите 0

Solved fully constrained sketch.

2. Обновите деталь.

Обозреватель Щелкните по пиктограмме Update Part.

Контекстное Меню В графической области, щелкните правой кнопкой мыши и
выберите Update Part

Пиктограмма Update Part

Меню Desktop Part → Update Part

Команда AMUPDATE

3. Ответьте на подсказку следующим образом:
Enter an option [active Part/All parts] <active Part>: нажмите ENTER

4. Измените горизонтальный размер эскиза, управляющий рабочей точкой.

Контекстное Меню В графической области, щелкните правой кнопкой мыши и
выберите Dimensioning → Edit Dimension.

Пиктограмма Edit Dimension

Меню Desktop Design → Dimensioning → Edit Dimension

Команда AMMODDIM

5. Ответьте на запросы следующим образом:
Select dimension to change: Укажите горизонтальный размер

New value for dimension <0.6000>: Введите .75
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Solved fully constrained sketch.

6. Обновите деталь.

Обозреватель Щелкните по пиктограмме Update Part.

Контекстное Меню В графической области, щелкните правой кнопкой мыши и
выберите Update Part

Пиктограмма Update Part

Меню Desktop Part → Update Part

Команда AMUPDATE

7. Ответьте на подсказку следующим образом:
Enter an option [active Part/All parts] <active Part>: нажмите ENTER

8. Выключите видимость рабочей точки и ее размеров.

Обозреватель Щелкните правой кнопкой мыши по EXTRUDE_1 и выберите
Visible.

Пиктограмма Part Visibility

Меню Desktop Part → Part Visibility

Команда AMVISIBLE

9. В диалоговом окне Desktop Visibility выберите ярлычок Part и выберите Work Points.
Нажмите ОК для выхода из диалогового окна.

Диалоговое окно не отображается, если Вы используете Обозреватель.

Сохраните ваш файл.

Вы получите большее представление по созданию рабочих элементов по мере изучения
остальной части обучающих программ в этой книге.
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